
 
 

Intro to Computer Basics 

Desktop 
 

The desktop is the main screen area that you see 
after you turn on your computer and log on. 
Commonly found on the desktop are icons 
representing the Recycle Bin and applications such 
as Microsoft Word or Excel.   
 
Here’s a typical ECC desktop:  

 

Mousing Around  
 

Double-Click  
To double-click an item, move your mouse cursor over to the item on the screen, and then click twice 
quickly. If the two clicks are spaced too far apart, they might be interpreted as two individual clicks 
rather than as one double-click. 

Double-clicking is most often used to OPEN files or folders. 

 

Right-Click   
You click on the Right mouse button to bring up a menu of special tasks or 
options relating to where you just clicked. Clicking the secondary mouse 
button is called right-clicking. 

Here’s a screenshot of what happens when I type something in a Word 
doc and then right-click – Oodles of menu choices! 
 

 

Click & Drag 
Click once on an object but keep holding down the left button. Now, with 
that left mouse button still being held down, move the mouse pointer to a 
new location and then release the button. The object you were dragging 
should move with you.  

You can use this technique to move files and folders, arrange windows, and highlight text.   

 
ECC Professional Development  1 
                                                                                                                          



 
 

Moving Items (Drag-and-Drop)  
The most common way to move files and folders is by using the Drag-and-Drop method, which means 
that you select an item and then drag it to another location.  

First, find the file or folder you want to move. Make sure the destination for the file or folder you want 
to move is also visible. (For example, if you are moving a file from the Documents folder to the desktop, 
you might need to resize the Documents window so the desktop is visible.) Then drag the file or folder 
from the original location to the destination.   
 

Note:  If you drag an item to a different hard drive or to a removable storage device 
like a USB flash drive, the item will be copied instead of moved. (In this way, the file 
or folder won't be removed from its original location. Which is a good thing.          ) 

 

Taskbar 
The taskbar is the long horizontal bar at the bottom of your screen. Unlike the desktop, which can get 
obscured by the windows on top of it, the taskbar is visible almost all the time. It has four main sections: 
 

1. The Start Button, which opens the Start Menu. 
 
  

2. The Quick Launch toolbar, which lets you start programs with one click. 
  
 

3. Taskbar buttons, which show you which programs and documents you have open and allow you 
to quickly switch between them.  

Whenever you open a program, folder, or document, Windows creates a button on the 
taskbar corresponding to that item. Here’s a screenshot of my taskbar, where you can see 
I’m actively using Outlook, Word, Internet Explorer, and Windows Explore. 

  
 

 

4. The Notification Area, which includes a clock and icons that communicate the status of certain 
programs and computer settings.  

 

 

Start Menu 
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The Start Menu gives you access your computer's programs, files, folders, settings, and controls. Click 
the Start Button in the bottom-left corner of your screen to open the Start Menu. 

Windows 7 divides the Start Menu into two parts: 

The Left pane displays a list of commonly used programs. Certain 
programs are pinned so that they always appear in the Start Menu, 
while others are determined by Windows to be the programs you use 
most often. Clicking a program's name or icon launches the program, 
and the Start Menu closes. 

There is also an All Programs button, which opens a navigable list of 
every program installed on the computer.  
 
The Search box lets you search your computer for files, folders, and 
programs. (**You can also search for keywords or phrases that you 
know are in certain documents, when you can’t remember the 
name you saved it as.) 
 

The Right pane contains links to Windows features that you're likely to use. These include: 
 

• Documents: a folder to store text files, spreadsheets, presentations, and other kinds of 
documents. 
 

• Computer: a place to access disk drives and removable storage devices (e.g., USB drives) 
 

• Control Panel: Windows settings. Customize the appearance and functionality of your 
computer, add or remove programs, set up network connections, and manage user accounts. 
 

• Devices and Printers: a folder showing all connected printers, faxes, keyboards, webcams, 
scanners, mp3 players, cameras, etc. that you have plugged in to your computer. Removable 
storage devices (e.g., USB drives) will show up here as well. 
 

• Help and Support: here you can browse and search Help topics about using Windows and your 
computer. 

 

Also included in the Start Menu are options to Log Off or Shut Down your computer.  

Parts of ‘My Computer’ 
(While it’s now technically just ‘Computer’ in the Start Menu, if you ever search for help online, many 
tutorials, guides, and videos still refer to it as ‘My Computer.’)  
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Hard Disk Drives 
The hard disk, typically called the (C:) drive, is the primary 
storage device located inside your computer and is used to 
store all your applications, files, and folders.  
 

You may also have a shared drive in your department. Some 
offices have a (P:) drive or (S:) drive that is shared over the ECC 
network. If you put a file in this drive, other people who have 
access to the department’s shared drive can also open it. 

  

Devices with Removable Storage 
Removable storage devices are used for increasing storage 
space on a computer or for transferring information between computers. 

Common removable storage devices include: 

• USB drives (aka “Flash drive,” “Thumb drive,” “Memory stick”) 

• DVDs/CDs 

• External hard drives 

• CompactFlash memory cards  

• Secure Digital (SD) memory cards 

 

Windows (the boxes) 
Whenever you open a program, file, or folder, it appears on your screen in a box or frame called a 
window.  

When you have several programs running at once, each one displays in its own window. These windows 
can overlap one another. The window in front is known as the active window. Click any part of a 
window in the background to bring its contents to the front and make it the active window.  

 

Moving & Resizing Windows  
To move a window, point to its title bar with the mouse, then click-and-drag the window to the location 
you want.   
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To resize a window (make it smaller or bigger), point to any of the window's borders or corners. When 
the mouse cursor changes to a two-headed arrow                     , click and drag the border or corner to 
shrink or enlarge the window. 

 
Minimize / Maximize / Close Buttons 
In the top-right corner of a window are the Minimize, Maximize/Restore Down, and Close buttons. 
These buttons hide the window, resize it extra large or smaller, and close the window, respectively.  

 

 

 

                                        Minimize        Maximize/Restore Down            Close 

Files and Folders  

Files 
A file is a collection of related information that is stored on a computer. A file can be a text document, a 
picture, an application, and so on. 

Think of a file as a piece of paper. You organize those papers by putting them into their appropriate folders.  

 

 

 

 

 

 

 

 

Folders 
As we saw above, a folder is a container in which you can store and organize files.  
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Not only can folders hold files, but they also can hold other folders. This may seem a bit complicated at 
first, but we do this in real life all the time. Our main “Bills” folder might hold our Gas Bill folder, our 
Electric Bill folder, our Phone Bill folder, etc.  

A folder within a folder is usually called a subfolder. You can create any number of subfolders, and each 
can hold any number of files and additional subfolders. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

File extensions 
You can put lots of different types of files into your folders. For example, your “Summer Vacation 2014” 
folder might have a Word doc itinerary, a PDF packing list, and lots of pictures. 

Office 
Supplies 

Furniture Software 

Folder 

Subfolder 

January January 

  February 
 

  February 
 

January 
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Filename extensions are what tell you what type of file it is. Filename extensions come at the end, after 
the name of the file, and they’re typically three letters long. They will also often have an icon that 
indicates the type of file and the application that will open it. (See picture below.)  

By default, Windows hides filename extensions, so don’t worry if you don’t see it.  Below are some 
examples of common file types with their extensions: 
 

  File name Type of file... Opens with...  

 • document.doc  or .docx Word document  Microsoft Word  

 • spreadsheet.xls  or .xlsx Excel spreadsheet Microsoft Excel 

  • picture.jpg JPEG Image  Windows Picture Viewer  

  • newsletter.pdf Portable Document Format  Adobe Acrobat Reader  

  • compressed_file.zip Compressed file  WinZip 

  • presentation.ppt or .pptx PowerPoint presentation Microsoft PowerPoint 

 

 

 

 

 

 

 

 

 

 

 

 Libraries   
This is where you go to access your Documents, Music, 
Pictures, and Videos.   
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As we saw above, you can also access your Documents, Pictures, and Music from the Start Menu. But it 
can sometimes be easier to access these main folders directly from Windows Explore.  (More on 
Windows Explore below.) 
 

Windows Explorer 
You can get to the Windows Explorer feature by clicking on its yellow folder icon in the 
taskbar. Windows Explorer helps you take a look at files and folders. 

 

 
Looking at a Folder in Windows Explorer  
The Windows Explorer frame has a variety of parts that are designed to help you navigate around and 
work with files and folders more easily. Let’s take a look at some of the main ones.  
 

Folder part What it's used for... 

Address Bar   

 
 

This tells you where you are. You can also click on the folder names within the 
address bar to navigate to that folder.  

Back, 
Forward, & 
Up Buttons  

 

 

 

 
 

Click the Back and Forward buttons to navigate to other folders you have 
previously opened. Click the Back button to move "up" one directory (i.e. from 
‘Documents\Bills\Phone’  back to just ‘Documents\Bills’.) 
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Search Field   
You can use this field to search for titles, tags, or keywords 
in your documents. It’s very handy.  

               **Though actually, the best place to search for something is… 
 
…the Start Menu!   Searching for a 
keyword or phrase here will bring up 
everything from documents, to zip files, 
to emails that contain that word.  
 

It’s a great feature. I use it all the time.   

 

 

 

 
Opening Files and Folders  
Simply double-click a file or folder to open it. Files will open using the program associated with its file 
type.  (So if you double-click on a document you’d created in Microsoft Word, the Microsoft Word 
program will open up and your file will be there ready to go.)   
 
Folders will open in the large space in the Windows Explorer frame, and list all of its contents.  

 

Create New Folders 
There are lots of ways to create a new folder: 

 

 

1. Go to the location where you want to create a new folder. 

2. In the File menu, select New and then click Folder. A new folder appears with the default 
name, "New Folder," highlighted for renaming. 

3. Type a name for the new folder, and then press Enter. 
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You can also create a new folder by right-clicking: right-click a blank area in a folder window or on 
the desktop, select New and then click Folder.  

 

In the Windows Explorer frame, click the "New Folder" button. 

 

 
 

 

Rename 
To rename a file or folder, find it in Windows 
Explorer. Then, right-click on it. A menu will 
appear. Select ‘Rename.’ (See picture to the 
right.) 

**By the way, you can also use this 
same method to Delete files. The 
‘Delete’ choice is just above ‘Rename.' 
 

A box will appear 
around the current 
file name, and that 
current name will 
be highlighted in 
blue.  
 
Start typing the 
new name you 
want, then hit ‘Enter’ 
when you’re done.  
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Delete 
When you delete a file or folder, the file or folder is not deleted right away. Instead, it is stored in the 
Recycle Bin until the Recycle Bin is emptied.   To delete a file or folder: 

• You can use the steps above and select ‘Delete’ instead of ‘Rename.’ 
 

• Or you can select a file or folder and press the Delete key on the keyboard. 
 

• You can also delete a file by clicking & dragging it over to the Recycle Bin icon on your desktop. 
Bring the file on top of the Recycle Bin, then let go of the left mouse button.  (Technically this 
makes it a drag & drop.         ) 
 

Cut, Copy, and Paste 
"Cut and Paste" and "Copy and Paste" are other methods of transferring files or folders (or text) from a 
source to a destination.  
 
When you Cut a file or folder, it is removed from its original location. When you Copy a file or folder, you 
are making a duplicate of the original item that you can then modify, delete, or store independently of 
the original. 
 
To Copy and Paste a file or folder:  

1. Go to the location that contains the file or folder you want to copy. 

2. Right click the file or folder.  On the menu that pops up, select Copy.  

3. Go to the location where you want to paste the file. 

4. Right click and then select Paste. 

 

Menu Bar 
Located underneath the Title Bar, the Menu Bar contains lists of options that you can click to perform 
commands (actions) in a program. When combined with the Toolbar (see next page), it’s also known as 
“The Ribbon.” 
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Menu Bar (cont’d) 
Click a menu (i.e. File, Edit, View, etc.) to open it. You can then move your mouse pointer along that 
menu and its other sub-menus open automatically; you don't need to click the Menu Bar again.  

(If a command is unavailable and cannot be clicked, it is shown in gray.) 
 

Toolbars 
Toolbars typically appear just below the menu bar and provide access to frequently-used commands in 
the form of buttons. (These commands usually appear in the menus, too, but toolbars let you select a 
command with just one click.) 

 

  
  
 

 

Clicking a toolbar button performs a command. To find out what a particular toolbar button does, hover 
over it with your mouse. The button's name or function appears. 

 

Undo 
Undoing your last action:  

Most programs allow you to undo actions you took or mistakes you made. For example, if you deleted a 
paragraph in a document accidentally, you can get it back by using the Undo command. If you draw a 
line in Paint that you don't want, you can ‘undo’ your line right away and it vanishes. 

 
To undo an action: 

• On the Edit menu, click ‘Undo.’  (You can also click the Undo icon     .)      
 

Programs / Applications 
Programs perform a specific task, such as word processing, accounting, or data management. (For 
example, Microsoft Word is a word processing program.) Programs are also called applications. 
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Start a Program 
You can start a program by double-clicking its icon on the desktop. You can also double-click a file that 
uses that program. (For example, double-clicking a Microsoft Word document starts Microsoft Word, 
and then opens the file in the program.)  
 

As we saw above, you can also start a program by clicking on it from the Start Menu.  
 

The left pane of the Start Menu contains shortcuts to programs, including your Internet 
browser, e-mail program, and recently-used programs, as well as a list of All Programs.  
To start a program, click it.   

 

 

New 
If your program doesn't open a new document automatically when 
it starts, you can do it yourself: 
 
   •  Click the File menu in the program you are using, and then click  
       New.  

(If you can open more than one type of document in the program, 
you might also need to select the type you want from a list.) 

 

Save 
You can use this same menu to Save your document. 

Saving a document allows you to name it and to store it 
permanently on your computer's hard disk. That way, the 
document is preserved even when your computer is turned off, and 
you can open it again later. 
 

To save a document or file: 

• Click the Save icon        or,  on the File menu, click ‘Save’.  If this is the first time you are 
saving the file, you’ll be asked to provide a name for it. 
 
** To avoid losing work unexpectedly due to a power failure or other problem, save your 
document often. 
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Note that clicking ‘Save’ will overwrite any previous saved versions of this same file. 
(Which is why it’s a good idea to create different versions of the file with different names 
as you go along. See below.) 

 

Save As 
Save As is used when you want to save a file with a different name to create a new copy of a file during 
the creation process. In that way, you can have different versions of the same document and can return 
to a previous stage. 

I like to click ‘Save As’ and then rename my files with dates as I go along, such as “Windows 7 Handout  
6-11-14”  and “Windows 7 Handout 6-19-14.” Then I know which one is the latest version (and I can go 
back to the previous version if I have to.) 

 

Close 
We saw before that clicking the red X in the corner will close the document or program 
you’re working on. 

You can also close a program by going into the File menu (like we did for New, Save, and Save As.)  Click 
‘Close’ to close the document or file you’re working on, or click ‘Exit’ to exit the whole program.   
 

 
Print 

To print a page go to the File menu and select ‘Print.’ A window 
will pop up with options for how many copies and which pages you 
want to print. Other options are also available depending on the 
printer. 

 
Common print options 
The options that are available to you will depend on the program 
and the printer that you're using.  
 
To access some options, you might need to click a "Preferences," 
"Properties," or "Advanced Options" link or button within the Print 
dialog box. 

 
Let’s take a look at some of these options… 
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 Printer selection   Allows you to choose a printer from a list of printers that are connected to 
your computer. 
 

Sometimes ECC computers have “OneNote” chosen as 
their default printer. If your document isn’t printing for 
some reason, make sure a connected printer is selected, 
rather than “One Note.”  
 

 Page range   Allows you to print specific pages or sections of a document. To print individual 
pages or a sequence (range) of pages, type the page numbers separated by commas or hyphens. 
For example, if you type 1,4,5-7 then only pages 1 and 4, and then pages 5 through 7, will be 
printed. 
 
 The Selection option allows you to print only the text or graphics that you have selected 

in the document (i.e., highlighted using your mouse.)  
 

 The Current Page option allows you to print only the currently displayed page. 
 
 

 Number of copies and Collate   Allows you to print more than one copy of a document or 
picture at a time.  
 

Note:  Use the Collate option to print all pages in a document at once, in 
order, before printing more copies of the document.   

 
(This is instead of the printer making a whole bunch of copies of page 1, then 
a bunch of copies of page 2, and you having to put them in order later.) 

 
 

 Page orientation   Also referred to as the paper layout, this option allows you to print content 
as a tall page (Portrait) or wide page (Landscape). 
 

 
 Paper size  If your printer can print on more than one size of paper, this option allows you to 

select the paper size that you have loaded in the printer. (Ex: 8 ½ x 11, envelopes,  11 x 17, etc.) 
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Print Options (cont’d) 
 
 Output or paper source   Also referred to as 

output destination or paper tray, this option allows 
you to specify which paper tray the printer should 
use. That way, you can load and store different 
paper sizes in each tray. 
 

 Double-sided printing   Also referred to as duplex 
or two-sided printing, this option allows you to 
print on both sides of a sheet of paper. This option 
is only available if your printer supports it. 
 

 Print in color or black ink   This option is only 
available if your printer supports it. 

 

Flickr Creative Commons by Mava 
 

Help 
Many programs have a Help button in the upper right-hand corner. Often it is represented by a question 
mark.           The Help button will usually take you to a searchable Help webpage.  

You can type in topics (e.g., “make a table of contents”) or even a problem you’re encountering (e.g., 
“table of contents not updating.”) 
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